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Acrobat	User	Guide	Introduction	to	Acrobat	Workspace	Creating	PDFs	Editing	PDFs	Scan	and	OCR	Forms	Combining	files	Sharing,	reviews,	and	commenting	Saving	and	exporting	PDFs	Security	Electronic	signatures	Printing	Accessibility,	tags,	and	reflow	Searching	and	indexing	Creating	PDF	indexes	Searching	PDFs	Multimedia	and	3D	models	Print
production	tools	(Acrobat	Pro)	Preflight	(Acrobat	Pro)	Color	management	Booklets	are	documents	with	multiple	pages	arranged	on	sheets	of	paper	that,	when	folded,	present	the	correct	page	order.	You	can	create	2-up	saddle-stitched	booklets,	where	two	side-by-side-pages,	printed	on	both	sides,	are	folded	once	and	fastened	along	the	fold.	The	first
page	prints	on	the	same	printed	sheet	as	the	last	page.	The	second	page	prints	on	the	same	sheet	as	the	second-to-last	page,	and	so	on.	Each	page	is	automatically	centered	on	the	sheet,	and	large	pages	are	scaled	(shrunk)	to	fit	the	printable	area.	When	you	collate,	fold,	and	staple	the	double-sided	pages,	the	result	is	a	single	book	with	correct
pagination.	To	print	booklets,	your	printer	must	support	either	automatic	or	manual	duplex	printing	(printing	on	both	sides	of	the	paper).	Manual	duplex	printing	requires	two	separate	printing	passes:	one	to	print	the	front	side,	and	another	to	print	the	back	side.	To	find	out	whether	your	printer	supports	duplex	printing,	check	the	printer	manual	or
contact	the	printer	manufacturer.	Multipage	document	(left),	pages	arranged	in	booklet	layout	(center),	and	pages	printed	and	folded	into	new	booklet	(right)	Choose	File	>	Print	and	select	the	printer.	Specify	which	pages	to	print:	To	print	pages	from	front	to	back,	select	All.	To	divide	a	large	booklet	into	smaller	groupings,	select	Pages	and	specify	a
page	range	for	the	first	grouping.	Print	each	page	range	separately.	To	print	certain	pages	on	a	different	paper	or	paper	stock,	specify	those	pages	using	the	Sheets	From/To	option.	Click	the	Properties	button	and	select	the	correct	paper	tray	and	any	other	options	as	necessary.	Choose	additional	page	handling	options.	The	Preview	image	changes	as
you	specify	options.	Determines	which	sides	of	the	paper	print.	Choose	Both	Sides	to	automatically	print	both	sides	of	the	paper	(your	printer	must	support	automatic	duplex	printing).	Choose	Front	Side	Only	to	print	all	pages	that	appear	on	the	front	side	of	the	paper.	After	these	pages	print,	flip	them,	choose	File	>	Print	again,	and	choose	Back	Side
Only.	Depending	on	the	printer	model,	you	might	have	to	turn	and	reorder	the	pages	to	print	the	back	sides.	If	your	printer	does	not	support	Automatic	Duplex	printing,	you'll	need	to	turn	or	flip	the	pages	and	feed	them	back	in.	The	exact	steps	depend	on	your	printer	model,	and	you	can	update	the	settings	using	the	printer	Properties	in	the	Print
dialog	box.	For	more	information,	see	Double-sided	Printing.	Auto-Rotate	Pages	Within	Each	Sheet	Automatically	rotates	each	page	for	the	best	fit	in	the	printable	area.	Specifies	the	first	and	last	sheet	to	print.	Acrobat	determines	which	sheets	must	print	to	accommodate	the	print	job.	For	example,	if	you	have	a	16-page	document,	then	sheets	1
through	4	print.	Determines	the	orientation	for	the	binding.	Choose	Left	for	text	read	left-to-right;	choose	Left	(Tall)	for	paper	folded	on	the	long	side,	where	the	printable	area	is	long	and	narrow.	Choose	Right	for	text	read	right-to-left	or	for	Asian-style	vertical	reading;	choose	Right	(Tall)	for	paper	folded	on	the	long	side.	Compare	Right	binding	with
Right	(Tall).	To	prevent	others	in	a	shared	printing	environment	from	printing	on	your	pages	before	you	print	the	back	side,	consider	printing	the	back	side	pages	using	a	different	paper	tray.	Print	PDFs	in	a	PDF	Portfolio	A	PDF	Portfolio	contains	multiple	documents	wrapped	in	one	PDF.	You	can	print	the	component	PDFs	in	a	PDF	Portfolio
individually	or	together.	Documents	print	in	alphabetical	order,	regardless	of	the	order	of	files.	Open	the	PDF	Portfolio.	To	print	only	certain	PDFs,	select	those	PDFs.	Choose	File	>	Print,	and	then	choose	one	of	the	following:	Prints	all	the	PDFs	in	the	PDF	Portfolio.	Prints	the	selected	PDFs.	This	option	is	available	only	when	multiple	files	are	selected
in	the	list	of	component	documents.	Choose	applicable	printing	options,	and	click	OK.	You	must	use	the	native	application	to	print	any	component	file	that	is	not	a	PDF.	To	open	a	component	file	in	its	native	application,	right-click	the	file	and	choose	Open	File	In	Native	Application.	(The	native	application	must	be	installed	for	you	to	open	the	file.)	You
can	print	the	pages	associated	with	bookmarks	directly	from	the	Bookmarks	tab.	Bookmarks	appear	in	a	hierarchy,	with	parent	bookmarks	and	child	(dependent)	bookmarks.	If	you	print	a	parent	bookmark,	all	page	content	associated	with	child-level	bookmarks	also	prints.	Not	all	bookmarks	display	page	content,	and	therefore	cannot	be	printed.	For
example,	some	bookmarks	open	a	file	or	play	a	sound.	If	you	select	a	mix	of	printable	and	nonprintable	bookmarks,	the	nonprintable	bookmarks	are	ignored.	Bookmarks	made	from	tagged	content	always	display	page	content	because	the	tagged	content	represents	printable	elements	in	the	document	structure,	such	as	headings	and	figures.	Open	a
PDF	with	bookmarks.	If	necessary,	choose	View	>	Show/Hide	>	Navigation	Panes	>	Bookmarks	so	the	bookmarks	appear	in	the	navigation	pane.	Select	one	or	more	bookmarks,	and	then	right-click	the	selection.	Choose	Print	Page(s)	from	the	menu.	Multipage	PDF	printed	as	a	booklet:	four	pages	per	sheet,	printed	both	sides,	left-side	binding.	Print	a
multi-page	document	as	booklet:	Select	a	printer	from	the	menu	at	the	top	of	the	Print	dialog	box.	In	the	Pages	to	Print	area,	select	which	pages	you	want	in	the	booklet.	All	prints	pages	from	front	to	back.	Pages	specifies	a	page	range	for	printing	a	smaller	grouping	of	a	large	booklet.	You	divide	a	large	booklet	into	smaller	groupings,	and	then	print
each	page	range	separately.	Under	Page	Sizing	&	Handling,	choose	Booklet.	In	the	Booklet	Subset	pop-up	menu,	select	one	of	the	following	options:	Both	sides	(duplex	printers)	automatically	prints	both	sides	of	the	paper,	if	your	printer	supports	automatic	duplex	printing,	or	Front	side	only	/	Back	side	only	(for	non-duplex	printers).	If	your	printer
can’t	automatically	print	both	sides,	you	can	first	print	the	front	sides	of	the	paper.	Then	reload	those	pages	and	print	the	back	sides.	Leave	the	numbers	in	the	Sheets	From	boxes	as	they	are.	Acrobat	or	Reader	determines	which	sheets	must	print	to	accommodate	the	print	job.	For	example,	if	you	have	a	16-page	PDF	and	you	selected	All	in	the	Print
Range	area,	then	sheets	1	through	4	print.	Select	Auto-Rotate	Pages	to	automatically	rotate	each	page	for	the	best	fit	in	the	printable	area.	Print	a	multi-page	document	as	booklet:	Select	a	printer	from	the	menu	at	the	top	of	the	Print	dialog	box.	In	the	Print	Range	area,	specify	which	pages	to	print:	All		Prints	pages	from	front	to	back.	Pages		Specifies
a	page	range	for	printing	a	smaller	grouping	of	a	large	booklet.	You	divide	a	large	booklet	into	smaller	groupings,	and	then	print	each	page	range	separately.	From	the	Page	Scaling	pop-up	menu,	select	Booklet	Printing.	Additional	controls	appear	beneath	the	Page	Scaling	pop-up	menu.	In	the	Booklet	Subset	pop-up	menu,	select	one	of	the	following
options:	Both	sides		(Duplex	printers)	Automatically	prints	both	sides	of	the	paper,	if	your	printer	supports	automatic	duplex	printing.	Front	side	only	/	Back	side	only	(for	non-duplex	printers)	If	your	printer	can't	automatically	print	both	sides,	you	can	first	print	the	front	sides	of	the	paper.	Then	reload	those	pages	and	print	the	back	sides.	Leave	the
numbers	in	the	Sheets	From	boxes	as	they	are.	Acrobat	or	Reader	determines	which	sheets	must	print	to	accommodate	the	print	job.	For	example,	if	you	have	a	16-page	PDF	and	you	selected	All	in	the	Print	Range	area,	then	sheets	1	through	4	print.	Select	Auto-Rotate	Pages	to	automatically	rotate	each	page	for	the	best	fit	in	the	printable	area.
Choose	an	option	from	the	Binding	pop-up	menu:	PDFprintfriendlySave	Money	&	the	Environment	Welcome	to	a	free	online	tool	for	rearranging	PDF	document	layout	to	print	multiple	pages	per	sheet	(also	called	N-up	printing).	It	can	be	used	to	position	two	(2-up)	or	more	document	pages	side	by	side	on	one	sheet,	for	example,	to	print	a	booklet	or	to
reduce	number	of	paper	sheets	needed	to	print	the	document.	You	can	quickly	join	2,	3,	4,	or	6	pages	in	one,	with	several	layout	and	orientation	options.	Available	layouts	are:	1x2,	1x3,	1x4,	2x1,	2x2,	2x3,	2x4,	3x1,	3x2,	4x1,	4x2,	4x3,	4x4,	giving	a	maximum	of	16	pages	per	sheet.	Learn	more	on	how	to	print	web	pages	using	Firefox's	printing	features.
Note:	If	a	web	page	is	available	in	Reader	View,	you	can	print	a	simplified	version	of	the	page	by	clicking	the	Reader	View	icon	in	the	address	bar,	before	printing.	This	will	save	paper	and	ink	by	removing	clutter	such	as	ads	and	background	images.	To	learn	more,	see	Print	simplified,	clutter-free	pages	in	Firefox.	Click	the	menu	button	and	then	click
Print….	This	will	open	a	print	preview	for	that	web	page.	Choose	your	printing	options:	Destination:	Use	the	dropdown	menu	to	choose	the	device	or	document	to	print	to	or	save.	Select	in	the	drop-down	menu	to	save	the	shown	preview	as	a	PDF	file.	Copies:	Choose	how	many	copies	to	make	(available	for	printers	and	faxes).	Orientation:	Allows	you
to	choose	between	portrait	and	landscape	orientation	of	the	printed	page.	Pages:	Allows	you	to	choose	what	pages	you	would	like	to	print.	Color	Mode:	This	allows	you	to	choose	whether	to	print	in	color	or	black	and	white	(this	may	not	be	customizable	for	some	printers).	More	settings:	Expand	this	section	for	more	options,	such	as	Paper	size,	Scale,
Pages	per	sheet,	Margins,	Format	(Original	or	Simplified,	if	available),	Print	headers	and	footers	and	Print	backgrounds.	(If	you	select	Simplified	under	Format,	you	won't	be	able	to	select	Print	backgrounds.)	After	adjusting	the	settings,	click	Print	to	start	printing.	We	have	been	gradually	rolling	out	this	improved	print	menu	since	Firefox	version	82.
If	you	do	not	see	the	new	print	menu	described	above,	follow	these	alternative	instructions:	Click	the	menu	button	and	then	click	Print….	In	the	Print	Preview	window	that	opens,	adjust	settings	for	what	you're	about	to	print,	if	necessary.	See	Print	window	settings	below	for	information	on	what	settings	can	be	changed.	Click	PrintOK	to	start	printing.
Click	the	menu	button	and	then	click	Print…	to	open	the	"print"	menu.	Adjust	the	settings	as	necessary.	For	more	advanced	settings	click	Show	Details.	See	the	"Default	'Print'	Menu"	and	"'Print'	Menu	with	Details	Shown"	sections	for	information	on	what	settings	can	be	changed.	After	adjusting	the	settings,	click	Print	to	start	printing.	Print:	See
Print	window	settings.	Page	Setup:	Pages:	Navigate	to	different	pages	by	entering	a	page	number	or	using	the	arrows.	Scale:	To	try	and	make	the	web	page	fit	on	fewer	sheets	of	printed	paper,	you	can	adjust	the	scale.	Shrink	To	Fit	automatically	adjusts	the	scale.	Orientation:	Select	Portrait	for	most	documents	and	web	pages.	Select	Landscape	for
very	wide	pages	and	images.	Simplify	Page:	Select	Simplify	Page	to	remove	clutter	and	save	paper	and	ink	when	printing	web	pages.	Remove	unwanted	ads,	unrelated	text	and	images,	and	blank	spaces	from	the	page	to	print	your	content	on	fewer	pages.	If	this	is	available	for	the	web	page	you're	on,	it	will	be	black	and	clickable.	Otherwise,	it	will	be
greyed	out.	Print	window	settings	Select	Printer	section:	Choose	the	printer	you	want	from	the	list.	You	can	move	the	slider	below	to	see	more	printers.	Note:	The	default	printer	is	usually	Microsoft	Print	to	PDF.	When	a	web	page	is	printed	with	the	selected	printer,	it	becomes	the	new	default	printer.	Click	on	Preferences	to	change	the	paper	size,
print	quality,	and	other	settings	specific	to	your	printer.	Print	range	section:	Lets	you	specify	which	pages	of	the	current	web	page	are	printed:	Select	All	to	print	everything.	Select	Pages	and	enter	either	a	range	of	pages	or	a	single	page.	For	example,	"1"	prints	only	the	first	page	and	"3-5"	prints	the	pages	from	3	to	5.	Select	Selection	to	print	only
the	part	of	the	page	you've	highlighted.	Copies	section:	Lets	you	specify	how	many	duplicates	you	want	to	print.	If	you	enter	more	than	1	in	the	Number	of	copies	field,	you	can	also	choose	whether	to	collate	them.	For	example,	if	you	choose	to	make	two	copies	and	select	Collate,	they	will	print	in	the	order	1,2,3,1,2,3.	Otherwise,	they	will	print	in	the
order	1,1,2,2,3,3.	Note:	The	following	settings	are	saved	as	Firefox	preferences	on	a	per-printer	basis.	Changing	the	page	setup	Format	and	Options	The	Format	&	Options	tab	allows	you	to	change:	Orientation:	Select	Portrait	for	most	documents	and	web	pages.	Select	Landscape	for	very	wide	pages	and	images.	Scale:	To	try	to	make	the	web	page	fit
on	fewer	sheets	of	printer	paper,	you	can	adjust	the	scale.	Shrink	to	fit	automatically	adjusts	the	scale.	Options:	Select	Print	Background	(colors	&	images)	to	have	Firefox	print	backgrounds	for	web	pages.	Otherwise,	Firefox	leaves	page	backgrounds	white.	The	Margins	&	Header/Footer	tab	allows	you	to	change:	Margins:	You	can	enter	the	width	of
the	page	margins	for	the	top,	bottom,	left,	and	right	sides	of	the	page	separately.	Headers	&	Footers:	Use	the	dropdown	menus	to	select	what	appears	on	the	printed	page.	The	top-left	dropdown	box's	value	appears	at	the	top-left	corner	of	the	page;	the	top-center	dropdown	box's	value	appears	at	the	top-center	portion	of	the	page	and	so	on.	Choose
from:	--blank--:	Nothing	will	be	printed.	Title:	Print	the	title	of	the	page.	URL:	Print	the	web	address	of	the	page.	Date/Time:	Print	the	date	and	time	when	the	page	was	printed.	Page	#:	Print	the	page	number.	Page	#	of	#:	Print	the	page	number	and	total	number	of	pages.	Custom...:	Enter	your	own	header	or	footer	text.	This	can	be	used	to	show	a
company	or	organization	name	at	the	top	or	bottom	of	every	printed	page.	Click	OK	to	finish	making	changes	and	close	the	Page	Setup	window.	The	default	print	menu	is	what	shows	up	before	you	click	Show	Details.	This	shows	basic	information	for	taking	a	page	and	printing	as	is,	customizable	settings:	Printer:	By	clicking	on	the	drop-down	menu,
you	can	select	a	printer	to	print	from.	Presets:	Here	you	can	select	a	preset	for	your	printer	to	use	when	printing.	Copies:	This	allows	you	to	pick	how	many	copies	of	the	printed	page	you	would	like.	It	is	followed	by	a	checkmark	so	that	you	can	decide	if	you	want	to	print	single,	or	double-sided.	Pages:	This	allows	you	to	choose	what	pages	you	would
like	to	print.	This	is	the	print	menu	with	both	the	default	settings	and	more	advanced	settings	that	you	can	change.	While	the	top	section	of	this	"Print"	menu	stays	the	same,	the	bottom	section	can	be	changed	to	show	different	settings	by	changing	your	selection	in	the	drop-down	menu	around	the	middle	of	the	menu.	In	the	top	section	you	can	to
change:	Paper	Size:	Here	you	can	select	something	different	should	you	not	be	printing	on	the	standard	US	Letter	paper	size.	Orientation:	Choose	between	portrait	or	landscape	orientation.	Scale:	This	changes	how	big	or	small	the	web	page	appears	when	printed.	As	the	bottom	section	varies	based	on	what	is	selected	in	the	dropdown	menu,	these
sections	are	laid	out	below.	Firefox	This	section	has	options	made	possible	specifically	by	Firefox:	Option:	Here	you	can	choose	to	print	the	chosen	selection	only,	and	you	can	inform	the	printer	to	alter	the	scaling	so	that	the	printed	image	fills	the	width	of	the	page.	Appearance:	This	gives	you	the	choice	of	printing	background	colors/images.	Page
Headers/Footers:	This	allows	you	to	alter	the	header	and	footer	of	the	page(s)	printed	using	the	selections	from	the	drop-down	menu.	Layout	This	section	has	options	on	how	the	printer	should	print	the	web	page(s)	on	each	page:	Pages	per	Sheet:	This	tells	the	printer	how	many	web	pages,	or	duplicates	of	the	web	page,	should	be	placed	on	each	sheet
of	paper.	Layout	Direction:	This	tells	the	printer	what	order	the	web	pages	should	be	printed	in.	Border:	This	allows	you	to	choose	a	border	in	which	the	web	page(s)	will	be	contained.	Two	Sided:	This	allows	you	to	choose	where	room	should	be	made	on	a	page	for	binding.	As	well	as	the	option	to	flip	or	reverse	page	orientation.	Paper	Handling	This
section	controls	how	the	web	page	is	printed.	It	has	the	following	settings.	Collate	Pages:	An	option	to	tell	your	printer	to	organize	pages	by	signature.	Pages	to	Print:	Choose	what	pages	should	be	printed.	Page	Order:	A	section	to	let	you	decide	how	to	order	the	printed	pages.	Destination	Paper	Size:	What	size	of	paper	to	be	printed	on	to.	Cover	page
This	section	allows	you	to	print	a	cover	page	before	or	after	the	printed	pages.	Water	Mark	This	section	allows	you	to	add	a	watermark	to	what	you	print,	choose	what	the	watermark	will	be,	and	pick	where	on	the	page(s)	the	watermark	will	be.	Supply	Levels	Should	your	printer	be	able	to	provide	your	computer	with	this	information,	this	section	will
inform	you	of	the	device's	current	supply	levels.	Advanced	tips	If	you	want	to	edit	the	web	page	content	before	printing,	you	can	use	an	extension	from	Firefox	Add-ons	such	as	Print	Edit	WE.	To	print	a	single	image	from	a	page,	you	can	typically	right-click	it	and	select	or	then	print	using	the	instructions	above.	Web	pages	can	set	themselves	up	to
appear	different	on	paper	to	how	they	look	on	screen,	so	don't	be	surprised	to	see	some	changes.	These	fine	people	helped	write	this	article:	AliceWyman,	Chris	Ilias,	Underpass,	Tonnes,	Nic	Matthew,	Michael	Verdi,	scoobidiver,	John99,	Swarnava	Sengupta,	user669794,	Mike	Cooper,	Wesley	Branton,	Lan,	Joni,	danv,	Artist,	GKFX,	Marcelo	Ghelman,
hdraisma,	Rok,	Jeff,	Angela	Lazar,	Arseniy,	PGGWriter,	Fabi
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